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Chapter 1

Introduction

1.1 About this document

This is the user’s guide for Free Pascal. It describes the installation and use of the Free Pascal
compiler on the different supported platforms. It does not attempt to give an exhaustive list of all
supported commands, nor a definition of the Pascal language. Look at the Reference Guide for
these things. For a description of the possibilities and the inner workings of the compiler, see the
Programmer’s Guide. In the appendices of this document you will find lists of reserved words and
compiler error messages (with descriptions).

This document describes the compiler as it is/functions at the time of writing. First consult the
README and FAQ files, distributed with the compiler. The README and FAQ files are, in case
of conflict with this manual, authoritative.

1.2 About the compiler

Free Pascal is a 32- and 64-bit Pascal compiler. The current version (2.2) can compile code for the
following processors:

e Intel 1386 and higher (1486, Pentium family and higher)
e AMD64/x86_64

e PowerPC

e PowerPC64

e SPARC

e ARM

e The m68K processor is supported by an older version.
The compiler and Run-Time Library are available for the following operating systems:

e DOS
e LINUX

e AMIGA (version 0.99.5 only)


file:../ref/ref.html
file:../prog/prog.html
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e WINDOWS
e Mac OS X
e 0S/2 (optionally using the EMX package, so it also works on DOS/Windows)
e FREEBSD
e BEOS

e SOLARIS
e NETBSD
e NETWARE
e OPENBSD
e MorphOS
e Symbian

The complete list is at all times available on the Free Pascal website.

Free Pascal is designed to be, as much as possible, source compatible with Turbo Pascal 7.0 and
Delphi 7 (although this goal is not yet attained), but it also enhances these languages with elements
like operator overloading. And, unlike these ancestors, it supports multiple platforms.

It also differs from them in the sense that you cannot use compiled units from one system for the
other, i.e. you cannot use TP compiled units.

Also, there is a text version of an Integrated Development Environment (IDE) available for Free
Pascal. Users that prefer a graphical IDE can have a look at the Lazarus or MSIDE projects.

Free Pascal consists of several parts :
1. The compiler program itself.
2. The Run-Time Library (RTL).

3. The packages. This is a collection of many utility units, ranging from the whole Windows 32
API, through native ZIP/BZIP file handling to the whole GTK-2 interface.

4. The Free Component Library. This is a set of class-based utility units which give a database
framework, image support, web support, XML support and many many more.

5. Utility programs and units.
Of these you only need the first two, in order to be able to use the compiler. In this document, we

describe the use of the compiler and utilities. The Pascal Language is described in the Reference
Guide, and the available routines (units) are described in the RTL and FCL Unit reference guides.

1.3 Getting more information.

If the documentation doesn’t give an answer to your questions, you can obtain more information on
the Internet, at the following addresses:

e http://www.freepascal.org/ is the main site. It contains also useful mail addresses and links to
other places. It also contains the instructions for subscribing to the mailinglist.


file:../ref/ref.html
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e http://community.freepascal.org: 10000/ is a forum site where questions can be posted.

Other than that, some mirrors exist.

Finally, if you think something should be added to this manual (entirely possible), please do not
hesitate and contact me at michael @freepascal.org. .

Let’s get on with something useful.


http://community.freepascal.org:10000/
mailto:michael@freepascal.org

Chapter 2

Installing the compiler

2.1

2.1.1

Before Installation : Requirements

Hardware requirements

The compiler needs at least one of the following processors:

1.

4
5.
6

An Intel 80386 or higher processor. A coprocessor is not required, although it will slow down
your program’s performance if you do floating point calculations without a coprocessor, since
emulation will be used.

An AMD64 or EMT64 processor.

A PowerPC processor.

. A SPARC processor

An ARM processor.

. Older FPC versions exist for the motorola 68000 processor, but these are no longer maintained.

Memory and disk requirements:

1.

2.

3.

8 Megabytes of free memory. This is sufficient to allow compilation of small programs.

Large programs (such as the compiler itself) will require at least 64 MB. of memory, but
128MB is recommended. (Note that the compiled programs themselves do not need so much
memory.)

At least 80 MB free disk space. When the sources are installed, another 270 MB are needed.

2.1.2 Software requirements
Under DOS

The DOS distribution contains all the files you need to run the compiler and compile Pascal programs.

Under UNIX

Under UNIX systems (such as LINUX) you need to have the following programs installed :

10
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1. GNU as, the GNU assembler.
2. GNU ld, the GNU linker.

3. Optionally (but highly recommended) : GNU make. For easy recompiling of the compiler and
Run-Time Library, this is needed.

Under Windows

The WINDOWS distributions (both 32 and 64 bit) contain all the files you need to run the compiler
and compile Pascal programs. However, it may be a good idea to install the mingw32 tools or the
cygwin development tools. Links to both of these tools can be foundon http://www. freePascal.org

Under OS/2

While the Free Pascal distribution comes with all necessary tools, it is a good idea to install the EMX
extender in order to compile and run programs with the Free Pascal compiler. The EMX extender
can be found on:

ftp://hobbes.nmsu.edu/pub/os2/dev/emx/v0.9d

Under Mac OS X

Mac OS X 10.1 or higher is required, and the developer tools or XCode should be installed.

2.2 Installing the compiler.

The installation of Free Pascal is easy, but is platform-dependent. We discuss the process for each
platform separately.

2.2.1 Installing under Windows

For WINDOWS, there is a WINDOWS installer, setup.exe. This is a normal installation program,
which offers the usual options of selecting a directory, and which parts of the distribution you want
to install. It will, optionally, associate the .pp or . pas extensions with the text mode IDE.

It is not recommended to install the compiler in a directory which has spaces in it’s path name.
Some of the external tools do not support filenames with spaces in them, and you will have problems
creating programs.

2.2.2 Installing under DOS or 0OS/2

Mandatory installation steps.

First, you must get the latest distribution files of Free Pascal. They come as zip files, which you
must unzip first, or you can download the compiler as a series of separate files. This is especially
useful if you have a slow connection, but it is also nice if you want to install only some parts of
the compiler distribution. The distribution zip files for DOS or OS/2 contain an installation program
INSTALL.EXE. You must run this program to install the compiler.

The screen of the DOS or OS/2 installation program looks like figure 2.1.

The program allows you to select:

11
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Figure 2.1: The DOS install program screen

[:]

General W

Continue

e What components you wish to install. e.g do you want the sources or not, do you want docs or
not. Items that you didn’t download when downloading as separate files, will not be enabled,
i.e. you can’t select them.

o Where you want to install (the default location is C: \PP).
In order to run Free Pascal from any directory on your system, you must extend your path variable to
contain the C: \PP\BIN directory. Usually this is done in the AUTOEXEC.BAT file. It should look
something like this :

SET PATH=%PATHS%;C:\PP\2.2\BIN\1386-DOS
for DOS or

SET PATH=%PATHS%;C:\PP\2.2\BIN\1386-0S2

for 0S/2. (Again, assuming that you installed in the default location).

On 0S/2, Free Pascal installs some libraries from the EMX package if they were not yet installed.
(The installer will notify you if they should be installed). They are located in the

C:\PP\DLL

directory. The name of this directory should be added to the LIBPATH directive in the config.sys
file:

LIBPATH=XXX;C:\PP\DLL

Obviously, any existing directories in the LIBPATH directive (indicated by XXX in the above exam-
ple) should be preserved.

12
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Figure 2.2:

Win32 C
[¥] BaSiE system for Win32 (required) {7345 KB)

Continue

Optional Installation: The coprocessor emulation

For people who have an older CPU type, without math coprocessor (i387) it is necessary to install a
coprocessor emulation, since Free Pascal uses the coprocessor to do all floating point operations.

The installation of the coprocessor emulation is handled by the installation program (INSTALL.EXE)
under DOS and WINDOWS.

2.2.3 Installing under Linux
Mandatory installation steps.

The LINUX distribution of Free Pascal comes in three forms:

e atar.gz version, also available as separate files.
e a.rpm (Red Hat Package Manager) version, and

e a.deb (Debian) version.
If you use the .rpm format, installation is limited to
rpm -1 fpc-X.Y.Z-N.ARCH.rpm

Where X . Y. Z is the version number of the .rpm file, and ARCH is one of the supported architectures
(1386, x86_64 etc.).

If you use Debian, installation is limited to
dpkg -1 fpc-XXX.deb

Here again, XXX is the version number of the .deb file.

13
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You need root access to install these packages. The .tar file allows you to do an installation below
your home directory if you don’t have root permissions.

When downloading the . tar file, or the separate files, installation is more interactive.

In case you downloaded the .tar file, you should first untar the file, in some directory where you have
write permission, using the following command:

tar —-xvi fpc.tar

We supposed here that you downloaded the file fpc.tar somewhere from the Internet. (The real
filename will have some version number in it, which we omit here for clarity.)

When the file is untarred, you will be left with more archive files, and an install program: an instal-
lation shell script.

If you downloaded the files as separate files, you should at least download the install.sh script, and
the libraries (in libs.tar.gz).

To install Free Pascal, all that you need to do now is give the following command:
./install.sh

And then you must answer some questions. They’re very simple, they’re mainly concerned with 2
things :

1. Places where you can install different things.

2. Deciding if you want to install certain components (such as sources and demo programs).

The script will automatically detect which components are present and can be installed. It will only
offer to install what has been found. Because of this feature, you must keep the original names when
downloading, since the script expects this.

If you run the installation script as the root user, you can just accept all installation defaults. If you
don’t run as root, you must take care to supply the installation program with directory names where
you have write permission, as it will attempt to create the directories you specify. In principle, you
can install it wherever you want, though.

At the end of installation, the installation program will generate a configuration file (fpc.cfg) for the
Free Pascal compiler which reflects the settings that you chose. It will install this file in the /etc
directory or in your home directory (with name .fpc.cfg) if you do not have write permission in the
/etc directory. It will make a copy in the directory where you installed the libraries.

The compiler will first look for a file .fpc.cfg in your home directory before looking in the /etc
directory.

2.3 Optional configuration steps

On any platform, after installing the compiler you may wish to set some environment variables. The
Free Pascal compiler recognizes the following variables :

e PPC_EXEC_PATH contains the directory where support files for the compiler can be found.
e PPC_CONFIG_PATH specifies an alternate path to find the fpc.cfg.
e PPC_ERROR_FILE specifies the path and name of the error-definition file.

e FPCDIR specifies the root directory of the Free Pascal installation. (e.g : C: \PP\BIN)

14
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These locations are, however, set in the sample configuration file which is built at the end of the
installation process, except for the PPC_CONFIG_PATH variable, which you must set if you didn’t
install things in the default places.

2.4 Before compiling

Also distributed in Free Pascal is a README file. It contains the latest instructions for installing
Free Pascal, and should always be read first.

Furthermore, platform-specific information and common questions are addressed in the FAQ. It
should be read before reporting any bug.

2.5 Testing the compiler

After the installation is completed and the optional environment variables are set as described above,
your first program can be compiled.

Included in the Free Pascal distribution are some demonstration programs, showing what the com-
piler can do. You can test if the compiler functions correctly by trying to compile these programs.

The compiler is called
e fpc.exe under WINDOWS, 0S/2 and DOS.
e fpc under most other operating systems.

To compile a program (e.g demo\text\hello.pp), copy the program to your current working
directory, and simply type :

fpc hello

at the command prompt. If you don’t have a configuration file, then you may need to tell the compiler
where it can find the units, for instance as follows:

fpc —Fuc:\pp\NNN\units\i386-go32v2\rtl hello
under DOS, and under LINUX you could type
fpc -Fu/usr/lib/fpc/NNN/units/i386-1inux/rtl hello

(replace NNN with the version number of Free Pascal that you are using). This is, of course, assuming
that you installed under C: \PP or /usr/lib/fpc/NNN, respectively.

If you got no error messages, the compiler has generated an executable called hello.exe under DOS,
08/2 or WINDOWS, or hello (no extension) under UNIX and most other operating systems.

To execute the program, simply type :
hello

or
./hello

on Unices (where the current directory usually is not in the PATH).

If all went well, you should see the following friendly greeting:

Hello world

15



Remark:

Chapter 3

Compiler usage

Here we describe the essentials to compile a program and a unit. For more advanced uses of the
compiler, see the section on configuring the compiler, and the Programmer’s Guide.

The examples in this section suppose that you have an fpc.cfg which is set up correctly, and which
contains at least the path setting for the RTL units. In principle this file is generated by the installation
program. You may have to check that it is in the correct place. (see section 5.2 for more information
on this.)

3.1 File searching

Before you start compiling a program or a series of units, it is important to know where the compiler
looks for its source files and other files. In this section we discuss this, and we indicate how to
influence this.

The use of slashes (/) and backslashes (\) as directory separators is irrelevant, the compiler will
convert to whatever character is used on the current operating system. Examples will be given using
slashes, since this avoids problems on UNIX systems (such as LINUX).

3.1.1 Command line files

The file that you specify on the command line, such as in
fpc foo.pp

will be looked for ONLY in the current directory. If you specify a directory in the filename, then the
compiler will look in that directory:

fpc subdir/foo.pp

will look for foo.pp in the subdirectory subdir of the current directory.

Under case sensitive file systems (such as LINUX and UNIX), the name of this file is case sensitive;
under other operating systems (such as DOS, WINDOWS NT, 0S/2) this is not the case.

3.1.2 Unit files

When you compile a unit or program that needs other units, the compiler will look for compiled
versions of these units in the following way:
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1. It will look in the current directory.
2. It will look in the directory where the source file resides.
3. It will look in the directory where the compiler binary is.

4. Tt will look in all the directories specified in the unit search path.

You can add a directory to the unit search path with the (-Fu (see page 26)) option. Every occurrence
of one of these options will insert a directory to the unit search path. i.e. the last path on the command
line will be searched first.

The compiler adds several paths to the unit search path:

1. The contents of the environment variable XXUNITS, where XX must be replaced with one of
the supported targets: GO32V2, LINUX,WIN32, 0S2, BEOS, FREEBSD, NETBSD.

2. The standard unit directory. This directory is determined from the FPCD IR environment vari-
able. If this variable is not set, then it is defaulted to the following:

e On LINUX:

/usr/local/lib/fpc/FPCVERSION
or
/usr/1lib/fpc/FPCVERSION

whichever is found first.

e On other OSes: the compiler binary directory, with ’../” appended to it, if it exists. For
instance, on Windows, this would mean

C:\FPC\2.2\units\i386-win32
This is assuming the compiler was installed in the directory

C:\FPC\2.2
After this directory is determined , the following paths are added to the search path:

(a) FPCDIR/units/FPCTARGET
(b) FPCDIR/units/FPCTARGET/rtl

Here target must be replaced by the name of the target you are compiling for: this is a combi-
nation of CPU and OS, so for instance

/usr/local/lib/fpc/2.2/units/i386-1inux/
or, when cross-compiling
/usr/local/lib/fpc/2.2/units/1386-win32/

The —Fu option accepts a single = wildcard, which will be replaced by all directories found on that
location, but not the location itself. For example, given the directories

rtl/units/i386-1inux
fcl/units/1386-1inux
packages/base

packages/extra

the command
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fpc -Fu"*/units/i386-1inux"
will have the same effect as
fpc —-Furtl/units/i386-1linux -Fufcl/units/i386-1inux

since both the rtl and fcl directories contain further units/i886-linux subdirectories. The packages
directory will not be added, since it doesn’t contain a units/i386-linux subdirectory.

The following command
fpc —-Fu"units/i386-linux/*"

will match any directory below the units/i386-linux directory, but will not match the units/i386-
linux directory itself, so you should add it manually if you want the compiler to look for files in this
directory as well:

fpc —-Fu"units/i1386-1inux" —-Fu"units/i1386-linux/*"

Note that (for optimization) the compiler will drop any non-existing paths from the search path, i.e.
the existence of the path (after wildcard and environment variable expansion) will be tested.

You can see what paths the compiler will search by giving the compiler the —vu option.

On systems where filenames are case sensitive (such as UNIX and LINUX), the compiler will :
1. Search for the original file name, i.e. preserves case.
2. Search for the filename all lowercased.

3. Search for the filename all uppercased.

This is necessary, since Pascal is case-independent, and the statements Uses Unitl; or uses
unitl; should have the same effect.

It will do this first with the extension .ppu (the compiled unit), .pp and then with the extension .pas.
For instance, suppose that the file foo.pp needs the unit bar. Then the command

fpc -Fu.. -Fuunits foo.pp
will tell the compiler to look for the unit bar in the following places:

1. In the current directory.

2. In the directory where the compiler binary is (not under LINUX).
3. In the parent directory of the current directory.

4. In the subdirectory units of the current directory

5. In the standard unit directory.

Also, unit names that are longer than 8 characters will first be looked for with their full length. If the
unit is not found with this name, the name will be truncated to 8 characters, and the compiler will
look again in the same directories, but with the truncated name.

If the compiler finds the unit it needs, it will look for the source file of this unit in the same directory
where it found the unit. If it finds the source of the unit, then it will compare the file times. If the
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source file was modified more recent than the unit file, the compiler will attempt to recompile the
unit with this source file.

If the compiler doesn’t find a compiled version of the unit, or when the —B option is specified, then
the compiler will look in the same manner for the unit source file, and attempt to recompile it.

It is recommended to set the unit search path in the configuration file fpc.cfg. If you do this, you
don’t need to specify the unit search path on the command line every time you want to compile
something.

3.1.3 Include files

If you include a file in your source with the {$I filename} directive, the compiler will look for
it in the following places:

1. It will look in the path specified in the include file name.
2. It will look in the directory where the current source file is.

3. it will look in all directories specified in the include file search path.

You can add files to the include file search path with the —T (see page 26) or -Fi (see page 26)
options.

As an example, consider the following include statement in a file units/foo.pp:

{$i ../bar.inc}

Then the following command :
fpc —-Iincfiles units/foo.pp
will cause the compiler to look in the following directories for bar.inc:

1. The parent directory of the current directory.
2. The units subdirectory of the current directory.

3. The incfiles subdirectory of the current directory.

3.1.4 Object files

When you link to object files (using the { $SL. file.o} directive, the compiler will look for this file
in the same way as it looks for include files:

1. It will look in the path specified in the object file name.
2. It will look in the directory where the current source file is.

3. It will look in all directories specified in the object file search path.

You can add files to the object file search path with the ~Fo (see page 26) option.
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3.1.5 Configuration file

Not all options must be given on the compiler command line. The compiler can use a configuration
file which can contain the same options as on the command line. Unless you specify the —n (see
page 24) option, the compiler will look for a configuration file fpc.cfg in the following places:

e Under UNIX (such as LINUX)

1. The current directory.
2. Your home directory, it looks for .fpc.cfg.

3. The directory specified in the environment variable PPC_CONFIG_PATH, and if it is
not set, it will look in the etc directory above the compiler directory. (For instance, if the
compiler is in /usr/local/bin, it will look in /usr/local/etc)

4. The directory /etc.
e Under all other OSes:

1. The current directory.
2. Ifitis set, the directory specified in the environment variable PPC_CONFIG_PATH.

3. The directory where the compiler is.

Versions prior to version 1.0.6 of the compiler used a configuration file ppc386.cfg. This file is still
searched, but its usage is considered deprecated. For compatibility, fpc.cfg will be searched first,
and if not found, the file ppc386.cfg will be searched and used.

The searching for ppc386.cfg will be removed from the compiler in version 2.4.0. To indicate this,
the compiler gives a warning as of version 2.3.1 if it uses a ppc386.cfg configuration file.

3.1.6 About long filenames

Free Pascal can handle long filenames on all platforms, except DOS. On Windows, it will use support
for long filenames if it is available (which is not always the case on older versions of Windows).

If no support for long filenames is present, it will truncate unit names to 8 characters.

It is not recommended to put units in directories that contain spaces in their names, since the external
GNU linker doesn’t understand such filenames.

3.2 Compiling a program

Compiling a program is very simple. Assuming that you have a program source in the file prog.pp,
you can compile this with the following command:

fpc [options] prog.pp

The square brackets [ ] indicate that what is between them is optional.

If your program file has the .pp or .pas extension, you can omit this on the command line, e.g. in
the previous example you could have typed:

fpc [options] prog

If all went well, the compiler will produce an executable file. You can execute it straight away; you
don’t need to do anything else.

20



CHAPTER 3. COMPILER USAGE

You will notice that there is also another file in your directory, with extension .0. This contains the
object file for your program. If you compiled a program, you can delete the object file (.0), but don’t
delete it if you compiled a unit. This is because the unit object file contains the code of the unit, and
will be linked in any program that uses it.

3.3 Compiling a unit

Compiling a unit is not essentially different from compiling a program. The difference is mainly that
the linker isn’t called in this case.

To compile a unit in the file foo.pp, just type :
fpc foo

Recall the remark about file extensions in the previous section.

When all went well, you will be left with 2 (two) unit files:

1. foo.ppu - this is the file describing the unit you just compiled.

2. fo0.0 - this file contains the actual code of the unit. This file will eventually end up in the
executables.

Both files are needed if you plan to use the unit for some programs. So don’t delete them. If you
want to distribute the unit, you must provide both the .ppu and .0 file. One is useless without the
other.

3.4 Units, libraries and smartlinking

The Free Pascal compiler supports smartlinking and the creation of libraries. However, the default
behaviour is to compile each unit into one big object file, which will be linked as a whole into your
program. Shared libraries can be created on most platforms, although current level of FPC support
may vary (they are e.g. not supported for GO32v2 and OS2 targets).

It is also possible to take existing units and put them together in 1 static or shared library (using the
ppumove tool, section 8.7, page 107).

3.5 Reducing the size of your program

When you created your program, it is possible to reduce the size of the resulting executable. This is
possible, because the compiler leaves a lot of information in the program which, strictly speaking,
isn’t required for the execution of the program.

The surplus of information can be removed with a small program called strip.The usage is simple.
Just type

strip prog

On the command line, and the strip program will remove all unnecessary information from your
program. This can lead to size reductions of up to 30 %.

You can use the —Xs switch to let the compiler do this stripping automatically at program compile
time. (The switch has no effect when compiling units.)
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Another technique to reduce the size of a program is to use smartlinking. Normally, units (including
the system unit) are linked in as a whole. It is however possible to compile units such that they can
be smartlinked. This means that only the functions and procedures that are actually used are linked
in your program, leaving out any unnecessary code. The compiler will turn on smartlinking with the
—XX (see page 31) switch. This technique is described in full in the programmers guide.
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Compiling problems

4.1

General problems

e IO-error -2 at ... : Under LINUX you can get this message at compiler startup. It means

4.2

typically that the compiler doesn’t find the error definitions file. You can correct this mistake
with the —Fr (see page 26) option under LINUX.

Error : File not found : xxx or Error: couldn’t compile unit xxx: This typically happens
when your unit path isn’t set correctly. Remember that the compiler looks for units only in
the current directory, and in the directory where the compiler itself is. If you want it to look
somewhere else too, you must explicitly tell it to do so using the —Fu (see page 26) option. Or
you must set up a configuration file.

Problems you may encounter under DOS

No space in environment.
An error message like this can occur if you call SET_PP .BAT in AUTOEXEC.BAT.
To solve this problem, you must extend your environment memory. To do this, search a line in

CONFIG.SYS like

SHELL=C: \DOS\COMMAND . COM

and change it to the following:
SHELL=C:\DOS\COMMAND.COM /E:1024

You may just need to specify a higher value, if this parameter is already set.

Coprocessor missing
If the compiler writes a message that there is no coprocessor, install the coprocessor emulation.

Not enough DPMI memory
If you want to use the compiler with DPMI you must have at least 7-8 MB free DPMI memory,
but 16 Mb is a more realistic amount.
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Compiler configuration

The output of the compiler can be controlled in many ways. This can be done essentially in two
distinct ways:

e Using command line options.

e Using the configuration file: fpc.cfg.

The compiler first reads the configuration file. Only then are the command line options checked. This
creates the possibility to set some basic options in the configuration file, and at the same time you
can still set some specific options when compiling some unit or program. First we list the command
line options, and then we explain how to specify the command line options in the configuration file.
When reading this, keep in mind that the options are case sensitive.

5.1 Using the command line options

The available options for the current version of the compiler are listed by category. Also, see chapter
A, page 124 for a listing as generated by the current compiler.

5.1.1 General options
-h Print a list of all options and exit.
-? Same as —h, waiting after each screenfull for the enter key.

-i Print copyright and other information. You can supply a qualifier, as —ixxx where xxx can be
one of the following:
D : Returns the compiler date.
V : Returns the short compiler version.
W : Return full compiler version.
SO : Returns the compiler OS.
SP : Returns the compiler processor.
TO : Returns the target OS.
TP : Returns the target processor.

-1 Print the Free Pascal logo and version number.

-n Ignore the default configuration file. You can still pass a configuration file with the @ option.
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5.1.2 Options for getting feedback

-vxxx Be verbose. xxx is a combination of the following :

e e : Show errors. This option is on by default.
e i : Display some general information.
e w : Issue warnings.

: Issue notes.

°
o B

: Issue hints.

: Issue informational messages.

°
b

: Report number of lines processed (every 100 lines).

: Show information on units being loaded.

: Show names of files being opened.

: Show names of procedures and functions being processed.

: Show message numbers.

°
Q Q T o <

: Notify on each conditional being processed.

e mxxX: xxX is a comma-separated list of messages numbers which should not be shown.
This option can be specified multiple times.

e d: Show additional debugging information.

e 0: No messages. This is useful for overriding the default setting in the configuration file.
e b : Show all procedure declarations if an overloaded function error occurs.

e x : Show information about the executable (Win32 platform only).

: Format errors in RHIDE/GCC compatibility mode.

[ ]
[a]

: Show all possible information. (this is the same as specifying all options)

: Tells the compiler to write filenames using the full path.

°
< O 0w

: Write copious debugging information to file. fpcdebug.txt..

e s : Write timestamps. Mainly for the compiler developers.

The difference between an error/fatal error/hint/warning/note is the severity:

Fatal The compiler encountered an error, and can no longer continue compiling. It will stop at once.

Error The compiler encountered an error, but can continue to compile (at most till the end of the
current unit).

Warning if there is a warning, it means there is probably an error, i.e. something may be wrong in
your code.

Hint Is issued if the compiler thinks the code could be better, but there is no suspicion of error.

Note Is some noteworthy information, but again there is no error.

The difference between hints and notes is not really very clear. Both can be ignored without too
much risk, but warnings should always be checked.
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5.1.3 Options concerning files and directories

-exxx Specify XXX as the directory containing the executables for the programs as (the assembler)
and 1d (the linker).

-FaXYZ load units XYZ after the system unit, but before any other unit is loaded. XYZ is a comma-
separated list of unit names. This can only be used for programs, and has the same effect as if
XYZ were inserted as the first item in the program’s uses clause.

-FeXXX' Set the input codepage to XXX. Experimental.
-FCxxx Set the RC compiler (resource compiler) binary name to XXX.

-Fd Disable the compiler’s internal directory cache. By default, the compiler caches the names all
files in a directory as soon as it looks for a single file in said directory. This ensures that
the correct case of all file names is used in the debug information and to create compiled
files when compiling on a case-preserving file systems under an OS that also support case-
sensitive file systems, and it can also increase performance. This feature can however cause
severe slowdowns on networked file systems, especially when compiling trivial programs in
directories containing many files, and such slowdowns can be addressed by disabling the cache
using this switch.

-FD Same as —e.
-Fexxx Write errors, etc. to the file named XxX.

-FExxx Write the executable and units to directory xxX instead of the current directory. If this option
is followed by a —o option —o (see page 29), and this option contains a path component, then
the —o path will override the —FE setting.

-Ffxxx Add xxx to the framework path (only for Darwin).
-Fixxx Add xxx to the include file search path.
-Flxxx Add xxX to the library search path. (This is also passed to the linker.)

-FLxxx (LINUX only) Use xxx as the dynamic linker. The default is /lib/ld-linux.s0.2, or /lib/Id-
linux.s0.1, depending on which one is found first.

-Fmxxx Load the unicode conversion table from file X.txt in the directory where the compiler is
located. Only used when —Fc is also in effect.

-Foxxx Add xxx to the object file search path. This path is used when looking for files that need to
be linked in.

-Frxxx Specify xxx as the file which contain the compiler messages. This will override the com-
piler’s built-in default messages, which are in english.

-FRxxx set the resource (.res) linker to XXX.

-Fuxxx Add xxx to the unit search path. Units are first searched in the current directory. If they
are not found there then the compiler searches them in the unit path. You must always supply
the path to the system unit. The XXX path can contain a single wildcard (*) which will be
expanded to all possible directory names found at that location. Note that the location itself is
not included in the list. See section 3.1.2, page 16 for more information about this option.

-FUxxx Write units to directory xxx instead of the current directory. It overrides the —FE option.
-Ixxx Add xxX to the include file search path. This option has the same effect as -Fi.
-FWxxx store generated Whole Program Optimization information in file XXX.

-Fwxxx Read Whole Program Optimization information from file Xxx.
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5.1.4 Options controlling the kind of output.
For more information on these options, see Programmer’s Guide.

-a Do not delete the assembler files (not applicable when using the internal assembler). This also
applies to the (possibly) generated batch script.

-al Include the source code lines in the assembler file as comments.

-an Write node information in the assember file (nodes are the way the compiler represents state-
ments or parts thereof internally). This is primarily intended for debugging the code generated
by the compiler.

-ap Use pipes instead of creating temporary assembler files. This may speed up the compiler on
0S/2 and LINUX. Only with assemblers (such as GNU if the internal assembler is used.

-ar List register allocation and release info in the assembler file. This is primarily intended for
debugging the code generated by the compiler.

-at List information about temporary allocations and deallocations in the assembler file.
-Axxx specify what kind of assembler should be generated. Here xxx is one of the following :

default Use the built-in default.

as Assemble using GNU as.

nasmcoff Coff (Go32v2) file using Nasm.

nasmelf EIf32 (LINUX) file using Nasm.

nasmwin32 WINDOWS 32-bit file using Nasm.

nasmwdosx WINDOWS 32-bit/DOSX file using Nasm.

nasmobj Object file using Nasm.

masm Object file using Masm (Microsoft).

tasm Object file using Tasm (Borland).

elf EIf32 (LINUX) using internal writer.

coff Coff object file (Go32v2) using the internal binary object writer.
pecoff PECoff object file (Win32) using the internal binary object writer.

-B Re-compile all used units, even if the unit sources didn’t change since the last compilation.

-b Generate browser info. This information can be used by an Integrated Development Environment
(IDE) to provide information on classes, objects, procedures, types and variables in a unit.

-bl The same as —b but also generates information about local variables, types and procedures.

-Caxxx Set the ABI (Application Binary Interface) to xxX. The —1 option gives the possible values
for Xxx.

-Cb Generate big-endian code.
-Cc Set the default calling convention used by the compiler.

-CD Create a dynamic library. This is used to transform units into dynamically linkable libraries on
LINUX.

-Ce Emulate floating point operations.

-Cfxxx Set the used floating point processor to XXX.
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-CFNN Set the minimal floating point precision to NN. Possible values are 32 and 64.

-Cg Enable generation of PIC code. This should only be necessary when generating libraries on
LINUX or other Unices.

-Chxxx Reserves xxx bytes heap. xxx should be between 1024 and 67107840.

-Ci Generate Input/Output checking code. In case some input/output code of your program returns
an error status, the program will exit with a run-time error. Which error is generated depends
on the I/O error.

-Cn Omit the linking stage.

-Co Generate Integer overflow checking code. In case of integer errors, a run-time error will be
generated by your program.

-CO Check for possible overflow of integer operations.
-CpXXX Set the processor type to XXX.

-CPX=N Set the packing for X to N. X can be PACKSET, PACKENUM or PACKRECORD, and N can
be a value of 1,2,4,8 or one of the keywords DEFAULT or NORMAL.

-Cr Generate Range checking code. If your program accesses an array element with an invalid index,
or if it increases an enumerated type beyond its scope, a run-time error will be generated.

-CR Generate checks when calling methods to verify if the virtual method table for that object is
valid.

-Csxxx Set stack size to xxx.

-Ct Generate stack checking code. If your program performs a faulty stack operation, a run-rime
error will be generated.

-CX Create a smartlinked unit when writing a unit. Smartlinking will only link in the code parts that
are actually needed by the program. All unused code is left out. This can lead to substantially
smaller binaries.

-dxxx Define the symbol name xxx. This can be used to conditionally compile parts of your code.
-D Generate a DEF file (for OS/2).

-Dd Set the description of the executable/library (WINDOWS).

-Dv Set the version of the executable/library (WINDOWS).

-E Same as -Cn.

-g Generate debugging information for debugging with gdb.

-gc Generate checks for pointers. This must be used with the —gh command line option. When this
options is enabled, it will verify that all pointer accesses are within the heap.

-gg Same as —g.

-gh Use the heaptrc unit (see Unit Reference). (Produces a report about heap usage after the program
exits)

-gl Use the lineinfo unit (see Unit Reference). (Produces file name/line number information if the
program exits due to an error.)
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-goXXX set debug information options. One of the options is dwarfsets: It enables dwarf set
debug information (this does not work with gdb versions prior to 6.5.

-gp Preserve case in stabs symbol names. Default is to uppercase all names.
-gs Write stabs debug information.

-gt Trash local variables. This writes a random value to local variables at procedure start. This can
be used to detect uninitialized variables.

-gv Emit info for valgrind.

-gw Emit dwarf debugging info (version 2).

-gw2 Emit dwarf debugging info (version 2).

-gw3 Emit dwarf debugging info (version 3).

-kxxx Pass xxx to the linker.

-Oxxx Optimize the compiler’s output; xxx can have one of the following values :

aPARAM=VALUE Specify alignment of structures and code. PARAM determines what should
be aligned; VALUE specifies the alignment boundary. See the Programmer’s Guide for a
description of the possible values.

g Optimize for size, try to generate smaller code.

G Optimize for time, try to generate faster code (default).

r Keep certain variables in registers (experimental, use with caution).
u Uncertain optimizations

1 Level 1 optimizations (quick optimizations).

2 Level 2 optimizations (-O1 plus some slower optimizations).

3 Level 3 optimizations (-02 plus —Ou).

oxxx Specify specific optimizations: n can be one of

REGVAR Use register variables

STACKFRAME Skip stack frames

LOOPUNROLL unroll (small) loops

TAILREC change tail recursion to non-recursive loop.

pxxx select processor xxx to optimize for. fpc -1 lists all available processor instruction
sets.

Wxxx Generate Whole-Program-Optimization information for feature xxx. fpc -i will
generate a list of possible values.

wxxx Perform Whole-Program-Optimization information for feature xxx. fpc -i will gen-
erate a list of possible values.

s Optimize for size rather than speed.
The exact effect of some of these optimizations can be found in the Programmer’s Guide.

-oxxx Use xxx as the name of the output file (executable). For use only with programs. The output
filename can contain a path, and if it does, it will override any previous —FE setting. If the
output filename does not contain a path, the ~FE setting is observed.

-pg Generate profiler code for gprof. This will define the symbol FPC_PROFILE, which can be
used in conditional defines.
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-s Do not call the assembler and linker. Instead, the compiler writes a script, PPAS.BAT under DOS,
or ppas.sh under LINUX, which can then be executed to produce an executable. This can be
used to speed up the compiling process or to debug the compiler’s output. This option can take
an extra parameter, mainly used for cross-compilation. It can have one of the following values:

h Generate script to link on host. The generated script can be run on the compilation platform
(host platform).

t Generate script to link on target platform. The generated script can be run on the target
platform. (where the binary is intended to be run)

r Skip register allocation phase (optimizations will be disabled).
-Txxx Specify the target operating system. xxx can be one of the following:

e emx : OS/2 via EMX (and DOS via EMX extender).
e freebsd : FreeBSD.

e g032v2 : DOS and version 2 of the DJ DELORIE extender.
e linux : LINUX.

e netbsd : NetBSD.

e netware : Novell Netware Module (clib).

e netwlibe : Novell Netware Module (libc).

e openbsd : OpenBSD.

e 0s2: OS/2 (2.x) using the EMX extender.

e sunos : SunOS/Solaris.

e watcom : Watcom compatible DOS extender

e wdosx : WDOSX extender.

e win32 : WINDOWS 32 bit.

e wince : WINDOWS for handhelds (ARM processor).

The available list of targets depends on the actual compiler binary. Use fpc -1 to get a list
of targets supported by the compiler binary.

-uxxx Undefine the symbol xxx. This is the opposite of the —d option.

-Ur Generate release unit files. These files will not be recompiled, even when the sources are avail-
able. This is useful when making release distributions. This also overrides the —B option for
release mode units.

-W Set some WINDOWS or 0S/2 attributes of the generated binary. It can be one or more of the
following
Bhhh Set preferred base address to hhh (a hexadecimal address)
C Generate a console application (+) or a gui application (-).
D Force use of Def file for exports.
F Generate a FS application (+) or a console application (-).
G Generate a GUI application (+) or a console application (-).
N Do not generate a relocation section.
R Generate a relocation section.

T Generate a TOOL application (+) or a console application (-).
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-Xx Specify executable options. This tells the compiler what kind of executable should be generated.
The parameter x can be one of the following:

e c: (LINUX only) Link with the C library. You should only use this when you start to port
Free Pascal to another operating system.

e d Do not use the standard library path. This is needed for cross-compilation, to avoid
linking with the host platform’s libraries.

e D : Link with dynamic libraries (defines the FPC_LINK_DYNAMIC symbol)

e e use external (GNU) linker.

e g Create debug information in a separate file and add a debuglink section to executable.
e i use internal linker.

e MXXX : Set the name of the program entry routine. The default is *main’.

e m : Generate linker map file.

e PXXX : Prepend binutils names with XXX for cross-compiling.

e rXXX : Set library path to XXX.

e Rxxx Prepend xxXx to all linker search paths. (used for cross compiling).

s : Strip the symbols from the executable.
S : Link with static units (defines the FPC_LINK_STATIC symbol).

t : Link static (passes the —static option to the linker).
X : Link with smartlinked units (defines the FPC_LINK_SMART symbol).

5.1.5 Options concerning the sources (language options)

For more information on these options, see Programmer’s Guide

-Mmode Set language mode to mode, which can be one of the following:
delphi Try to be Delphi compatible. This is more strict than the ob jfpc mode, since some
Free Pascal extensions are switched off.
fpc Free Pascal dialect (default).
macpas Try to be compatible with Macintosh Pascal dialects.

objfpc Switch on some Delphi extensions. This is different from Delphi mode, because some
Free Pascal constructs are still available.

tp Try to be TP/BP 7.0 compatible. This means no function overloading etc.

-Mfeature Select language feature feature. As of FPC version 2.3.1, the —-M command line
switch can be used to select individual language features. In that case, feature is one of the
following keywords:

CLASS Use object pascal classes.

OBJPAS Automatically include the ObjPas unit.

RESULT Enable the Result identifier for function results.

PCHARTOSTRING Allow automatic conversion of null-terminated strings to strings,
CVAR Allow the use of the CVAR keyword.

NESTEDCOMMENTS Allow use of nested comments.

CLASSICPROCVARS Use classical procedural variables.

MACPROCVARS Use mac-style procedural variables.
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REPEATFORWARD Implementation and Forward declaration must match completely.
POINTERTOPROCVAR Allow silent conversion of pointers to procedural variables.
AUTODEREF Automatic (silent) dereferencing of typed pointers.

INITFINAL Allow use of Initializationand Finalization
POINTERARITHMETICS Allow use of pointer arithmetic.

ANSISTRINGS Allow use of ansistrings.

OUT Allow use of the out parameter type.

DEFAULTPARAMETERS Allow use of default parameter values.
HINTDIRECTIVE Support the hint directives (deprecated, plat form etc.)
DUPLICATELOCALS ?

PROPERTIES Allow use of global properties.

ALLOWINLINE Allow inline procedures.

EXCEPTIONS Allow the use of exceptions.

The keyword can be followed by a plus or minus sign to enable or disable the feature.

-Rxxx Specify what kind of assembler you use in your asm assembler code blocks. Here xxx is
one of the following:

att asm blocks contain AT&T-style assembler. This is the default style.
intel asm blocks contain Intel-style assembler.
default Use the default assembler for the specified target.

direct asm blocks should be copied as is in the assembler, only replacing certain variables.
-S2 Switch on Delphi 2 extensions (ob jfpc mode). Deprecated, use —Mob jfpc instead.

-Sa Include assert statements in compiled code. Omitting this option will cause assert statements to
be ignored.

-Sc Support C-style operators, i.e. x=, +=, /= and -=.
-Sd Try to be Delphi compatible. Deprecated, use -Mde 1phi instead.

-SeN The compiler stops after the N-th error. Normally, the compiler tries to continue compiling
after an error, until 50 errors are reached, or a fatal error is reached, and then it stops. With this
switch, the compiler will stop after the N-th error (if N is omitted, a default of 1 is assumed).
Instead of a number, one of n, h or w can also be specified. In that case the compiler will
consider notes, hints or warnings as errors and stop when one is encountered.

-Sg Support the 1abel and goto commands. By default these are not supported. You must also
specify this option if you use labels in assembler statements. (if you use the AT&T style
assember)

-Sh Use ansistrings by default for strings. If this option is specified, the compiler will interpret the
string keyword as an ansistring. Otherwise it is supposed to be a shortstring (TP style).

-Si Support C++ style INLINE.
-SIXXX Set interfaces style to XXX.
-Sk Load the Kylix compatibility unit (fpcylix).

-Sm Support C-style macros.
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-So Try to be Borland TP 7.0 compatible. Deprecated, use Mt p instead.
-Ss The name of constructors must be init, and the name of destructors should be done.
-St Allow the static keyword in objects.

-Sx Enable exception keywords (default in Delphi/Objfpc mode). This will mark all exception re-
lated keywords as keywords, also in Turbo Pascal or FPC mode. This can be used to check for
code which should be mode-neutral as much as possible.

-Un Do not check the unit name. Normally, the unit name is the same as the filename. This option
allows them to be different.

-Us Compile a system unit. This option causes the compiler to define only some very basic types.

5.2 Using the configuration file

Using the configuration file fpc.cfg is an alternative to command line options. When a configuration
file is found, it is read, and the lines in it are treated as if you typed them on the command line. They
are treated before the options that you type on the command line.

You can specify comments in the configuration file with the # sign. Everything from the # on will
be ignored.

The algorithm to determine which file is used as a configuration file is decribed in 3.1.5 on page 20.

When the compiler has finished reading the configuration file, it continues to treat the command line
options.

One of the command line options allows you to specify a second configuration file: Specifying @foo
on the command line will open file foo, and read further options from there. When the compiler has
finished reading this file, it continues to process the command line.

The configuration file allows a type of preprocessing. It understands the following directives, which
you should place starting on the first column of a line:

#IFDEF
#IFNDEF
#ELSE
#ENDIF
#DEFINE
#UNDEF
#WRITE
#INCLUDE
#SECTION

They work the same way as their {$...} counterparts in Pascal source code. All the default defines
used to compile source code are also defined while processing the configuration file. For example,
if the target compiler is an intel 80x86 compatible linux platform, both cpu86 and 1inux will be
defined while interpreting the configuration file. For the possible default defines when compiling,
consult Appendix G of the Programmer’s Guide.

What follows is a description of the different directives.
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5.2.1 #IFDEF

Syntax:
#IFDEF name

Lines following # IFDEF are read only if the keyword name following it is defined.

They are read until the keywords #ELSE or #ENDIF are encountered, after which normal processing
is resumed.

Example :
#IFDEF VER2_2_0

-Fu/usr/lib/fpc/2.2.0/1linuxunits
#ENDIF

In the above example, /ust/lib/fpc/2.2.0/linuxunits will be added to the path if you’re compiling
with version 2.2.0 of the compiler.

5.2.2 #IFNDEF

Syntax:
#IFNDEF name

Lines following # IFNDEF are read only if the keyword name following it is not defined.

They are read until the keywords #ELSE or #ENDIF are encountered, after which normal processing
is resumed.

Example :

#IFNDEF VER2_2 0
-Fu/usr/1lib/fpc/2.2.0/1linuxunits
#ENDIF

In the above example, /usr/lib/fpc/2.2.0/linuxunits will be added to the path if you’re NOT compil-
ing with version 2.2.0 of the compiler.

5.2.3 #ELSE

Syntax:
#ELSE

#ELSE can be specified after a # IFDEF or # IFNDEF directive as an alternative. Lines following
#ELSE are read only if the preceding # IFDEF or # IFNDEF was not accepted.

They are skipped until the keyword #ENDIF is encountered, after which normal processing is re-
sumed.

Example :

#IFDEF VER2_2_2
-Fu/usr/1lib/fpc/2.2.2/1linuxunits
#ELSE
-Fu/usr/1lib/fpc/2.2.0/1linuxunits
#ENDIF
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In the above example, /ust/lib/fpc/2.2.2/linuxunits will be added to the path if you’re compiling
with version 2.2.2 of the compiler, otherwise /ust/lib/fpc/2.2.0/linuxunits will be added to the path.

5.2.4 #ENDIF

Syntax:
#ENDIF
#ENDIF marks the end of a block that started with # IF (N) DEF, possibly with an #ELSE between

them.

5.2.5 #DEFINE

Syntax:
#DEFINE name

#DEF INE defines a new keyword. This has the same effect as a ~dname command line option.

5.2.6 #UNDEF

Syntax:
#UNDEF name
#UNDEF un-defines a keyword if it existed. This has the same effect as a —uname command line

option.

5.2.7 #WRITE

Syntax:
#WRITE Message Text

#WRITE writes Message Text to the screen. This can be useful to display warnings if certain
options are set.

Example:

#IFDEF DEBUG

#WRITE Setting debugging ON...
—-g

#ENDIF

If DEBUG is defined, this will produce a line

Setting debugging ON...

and will then switch on debugging information in the compiler.
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5.2.8 #INCLUDE

Syntax:
#INCLUDE filename

#INCLUDE instructs the compiler to read the contents of filename before continuing to process
options in the current file.

This can be useful if you want to have a particular configuration file for a project (or, under LINUX,
in your home directory), but still want to have the global options that are set in a global configuration
file.

Example:

#IFDEF LINUX

#INCLUDE /etc/fpc.cfg
#ELSE

#IFDEF GO32V2

#INCLUDE c:\pp\bin\fpc.cfg
#ENDIF

#ENDIF

This will include /etc/fpc.cfg if you’re on a LINUX machine, and will include ¢ : \pp\bin\fpc.cfg
on a DOS machine.

5.2.9 #SECTION
Syntax:

#SECTION name

The #SECTION directive acts as a # IFDEF directive, only it doesn’t require an #ENDIF directive.
The special name COMMON always exists, i.e. lines following # SECTION COMMON are always read.

5.3 Variable substitution in paths

To avoid having to edit your configuration files too often, the compiler allows you to specify the
following variables in the paths that you feed to the compiler:

FPCFULLVERSION is replaced by the compiler’s version string.
FPCVERSION is replaced by the compiler’s version string.

FPCDATE is replaced by the compiler’s date.

FPCTARGET is replaced by the compiler’s target (combination of CPU-OS)
FPCCPU is replaced by the compiler’s target CPU.

FPCOS is replaced by the compiler’s target OS.
To have these variables subsituted, just insert them with a $ prepended, as follows:

-Fu/usr/1lib/fpc/$SFPCVERSION/rt1/S$FPCOS
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This is equivalent to
-Fu/usr/lib/fpc/2.2.2/rtl/1linux

if the compiler version is 2. 2. 2 and the target OS is LINUX.
These replacements are valid on the command line and also in the configuration file.

On the linux command line, you must be careful to escape the $ since otherwise the shell will attempt
to expand the variable for you, which may have undesired effects.

37



Remark:

Chapter 6

The IDE

The IDE (Integrated Development Environment) provides a comfortable user interface to the com-
piler. It contains an editor with syntax highlighting, a debugger, symbol browser etc. The IDE is
a text-mode application which has the same look and feel on all supported operating systems. It is
modelled after the IDE of Turbo Pascal, so many people should feel comfortable using it.

Currently, the IDE is available for DOS, WINDOWS and LINUX.

6.1 First steps with the IDE

6.1.1 Starting the IDE
The IDE is started by entering the command:

fp

at the command line. It can also be started from a graphical user interface such as WINDOWS.

Under WINDOWS, it is possible to switch between windowed mode and full screen mode by pressing
ALT-ENTER.

6.1.2 IDE command line options

When starting the IDE, command line options can be passed:
fp [-option] [-option] ... <file name>
Option is one of the following switches (the option letters are case insensitive):

-N (DOS only) Do not use long file names. WINDOWS 95 and later versions of WINDOWS provide
an interface to DOS applications to access long file names. The IDE uses this interface by
default to access files. Under certain circumstances, this can lead to problems. This switch
tells the IDE not to use the long filenames.

-Cfilename Read IDE options from filename. There should be no whitespace between the file name
and the -C.

-F Use alternative graphic characters. This can be used to run the IDE on LINUX in an X-term or
through a telnet session.
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-R After starting the IDE, change automatically to the directory which was active when the IDE
exited the last time.

-S Disable the mouse. When this option is used, the use of a mouse is disabled, even if a mouse is
present.

-Tttyname (LINUX/Unix only) Send program output to tty ttyname. This avoids having to con-
tinually switch between program output and the IDE.

The files given at the command line are loaded into edit windows automatically.

Remark: Under DOS/Win32, the first character of a command line option can be a / character instead of a —
character. So /S is equivalent to —S.

6.1.3 The IDE screen
After start up, the screen of the IDE can look like figure (6.1).

Figure 6.1: The IDE screen immediately after startup

At the top of the screen the menu bar is visible, at the bottom the status bar. The empty space
between them is called the desktop.

The status bar shows the keyboard shortcuts for frequently used commands, and allows quick access
to these commands by clicking them with the mouse. At the right edge of the status bar, the current
amount of unused memory is displayed. This is only an indication, since the IDE tries to allocate
more memory from the operating system if it runs out of memory.

The menu provides access to all of the IDE’s functionality, and at the right edge of the menu, a clock
is displayed.

The IDE can be exited by selecting "'FilelExit" in the menu ! or by pressing ALT-X.

Remark: If a file fp.ans is found in the current directory, then it is loaded and used to paint the background.
This file should contain ANSI drawing commands to draw on a screen.

I FilelExit" means select the item Exit’ in the menu "File’.
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6.2 Navigating in the IDE

The IDE can be navigated both with the keyboard and with a mouse, if the system is equipped with
a mouse.

6.2.1 Using the keyboard
All functionality of the IDE is available through use of the keyboard.

e It is used for typing and navigating through the sources.
e Editing commands such as copying and pasting text.
e Moving and resizing windows.

e [t can be used to access the menu, by pressing ALT and the appropriate highlighted menu letter,
or by pressing F10 and navigating through the menu with the arrow keys. More information
on the menu can be found in section 6.4, page 43.

e Many commands in the IDE are bound to shortcuts, i.e. typing a special combination of keys
will execute a command immediately.

e When working in a LINUX X-Term or through a telnet session, the key combination with ALT
may not be available. To remedy this, the CTRL-Z combination can be typed first. This means
that e.g. ALT-X can be replaced by CTRL-Z X.

e Alternatively, you can try the key combination ESC-X for ALT-X when working on LINUX.

o A complete reference of all keyboard shortcuts can be found in section 6.14, page 88.

6.2.2 Using the mouse

If the system is equipped with a mouse, it can be used to work with the IDE. The left button is used
to select menu items, press buttons, select text blocks etc.

The right mouse button is used to access the local menu, if available. Holding down the CTRL or
ALT key and clicking the right button will execute user defined functions. See section 6.12.4, page
85.

1. Occasionally, the manual uses the term "drag the mouse". This means that the mouse is moved
while the left mouse button is being pressed.

2. The action of mouse buttons may be reversed, i.e. the actions of the left mouse button can be
assigned to the right mouse button and vice versa 2. Throughout the manual, it is assumed that
the actions of the mouse buttons are not reversed.

3. The mouse is not always available, even if a mouse is installed:

e The IDE is running under LINUX through a telnet connection from a WINDOWS machine.

e The IDE is running under LINUX in an X-term under X-windows. In this case it depends
on the terminal program: under Konsole (the KDE terminal) it works.

2See section 6.12.4, page 85 for more information on how to reverse the actions of the mouse buttons.
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4. On Windows, the console has an option *Quick edit’, allowing text to be copied to the clipboard
by selecting text in the console window. If this mode is enabled, the mouse will not work. The
’Quick edit’” option should be disabled in the console window’s properties in order for the IDE
to receive mouse events.

6.2.3 Navigating in dialogs

Dialogs usually have a lot of elements in them such as buttons, edit fields, memo fields, list boxes
and so on. To activate one of these fields, choose one of the following methods:

1. Click on the element with the mouse.
2. Press the TAB key till the focus reaches the element.

3. Press the highlighted letter in the element’s label. If the focus is currently on an element that
allows editing, then ALT should be pressed simultaneously with the highlighted letter. For a
button, the action associated with the button will then be executed.

Inside edit fields, list boxes and memos, navigation is carried out with the usual arrow key commands.

6.3 Windows

Nowadays, working with windowed applications should be no problem for most WINDOWS and
LINUX users. Nevertheless, the following section describes how the windows work in order to derive
the most benefit from the Free Pascal IDE.

6.3.1 Window basics
A common IDE window is displayed in figure (6.2).

Figure 6.2: A common IDE window
noname0l.pas

The window is surrounded by a so-called frame, the white double line around the window.

At the top of the window 4 things are displayed:
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e At the upper left corner of the window, a close icon is shown. When clicked, the window will
be closed. It can also be closed by pressing ALT-F3 or by selecting the menu item ''Win-
dowlIClose". All open windows can be closed by selecting the menu item '"Windowl|Close
all".

e In the middle, the title of the window is displayed.

e Almost at the upper right corner, a number is visible. This number identifies the editor window,
and pressing ALT-NUMBER will jump to this window. Only the first 9 windows will get such
a number.

o At the upper right corner, a small green arrow is visible. Clicking this arrow zooms the window
so it covers the whole desktop. Clicking this arrow on a zoomed window will restore the old
size of the window. Pressing the F5 key has the same effect as clicking that arrow. The same
effect can be achieved with the menu item ""WindowlZoom". Windows and dialogs which
aren’t resizeable can’t be zoomed, either.

The right edge and bottom edges of a window contain scrollbars. They can be used to scroll the
window contents with the mouse. The arrows at the ends of the scrollbars can be clicked to scroll the
contents line by line. Clicking on the dotted area between the arrows and the cyan-coloured rectangle
will scroll the window’s content page by page. By dragging the rectangle the content can be scrolled
continuously.

The star and the numbers in the lower left corner of the window display information about the con-
tents of the window. They are explained in the section about the editor, see section 6.5, page 50.

6.3.2 Sizing and moving windows
A window can be moved and sized using the mouse and the keyboard.

To move a window:

e Using the mouse, click on the title bar and drag the window with the mouse.

e Using the keyboard, go into the size/move mode by pressing CTRL-F5 or selecting the menu
item ""WindowlSize/Move''. The window frame will change to green to indicate that the
IDE is in size/move mode. Now the cursor keys can be used to move the window. Press
ENTER to leave the size/move mode. In this case, the window will keep its size and position.
Alternatively, pressing ESC will restore the old position.

To resize a window:

e Using the mouse, click on the lower right corner of the window and drag it.

e Using the keyboard, go into the size/move mode by pressing CTRL-F5 or selecting the menu
item ""WindowISize/Move''. The window frame will change to green to indicate that the IDE
is in size/move mode. Now hold down the SHIFT key and press one of the cursor keys in order
to resize the window. Press ENTER to leave the size/move mode. Pressing ESC will restore the
old size.

Not all windows can be resized. This applies, for example, to dialog windows (section 6.3.4, page
43).

A window can also be hidden. To hide a window, the CTRL-F6 key combination can be used, or
the '""WindowlHide' menu may be selected. To restore a Hidden window, it is necessary to select it
from the window list. More information about the window list can be found in the next section.
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6.3.3 Working with multiple windows

When working with larger projects, it is likely that multiple windows will appear on the desktop.
However, only one of these windows will be the active window; all other windows will be inactive.

An inactive window is identified by a grey frame. An inactive window can be made active in one of
several ways:

e Using the mouse, activate a window by clicking on it.

e Using the keyboard, pressing F6 will step through all open windows. To activate the previously
activated window, SHIFT-F6 can be used.

e The menu item ""WindowINext'' can be used to activate the next window in the list of windows,
while Window | Previous will select the previous window.

e If the window has a number in the upper right corner, it can be activated by pressing ALT-
<NUMBER>.

e Pressing ALT-0 will pop up a dialog with all available windows which allows a quick activation
of windows which don’t have a number.

The windows can be ordered and placed on the IDE desktop by zooming and resizing them with
the mouse or keyboard. This is a time-consuming task, and particularly difficult with the keyboard.
Instead, the menu items '""Windowl|Tile'" and '"WindowlCascade'' can be used:

Tile will divide the whole desktop space evenly between all resizable windows.

Cascade puts all the windows in a cascaded arrangement.

In very rare cases the screen of the IDE may become mixed up. In this case the whole IDE screen
can be refreshed by selecting the menu item '"Windowl|Refresh display'.

6.3.4 Dialog windows

In many cases the IDE displays a dialog window to get user input. The main difference to normal
windows is that other windows cannot be activated while a dialog is active. Also the menu is not
accessible while in a dialog. This behaviour is called modal. To activate another window, the modal
window or dialog must be closed first.

A typical dialog window is shown in figure (6.3).

6.4 The Menu

The main menu (the gray bar at the top of the IDE) provides access to all the functionality of the
IDE. It also contains a clock, displaying the current time. The menu is always available, except when
a dialog is opened. If a dialog is opened, it must be closed first in order to access the menu.

In certain windows, a local menu is also available. The local menu will appear where the cursor is,
and provides additional commands that are context-sensitive.

6.4.1 Accessing the menu

The menu can be accessed in a number of ways:
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Figure 6.3: A typical dialog window

% ntax Code eneration erhosze FOUSEDR zzembler

Suntax Switches

Conditio al defines

1. By using the mouse to select items. The mouse cursor should be located over the desired menu
item, and a left mouse click will then select it.

2. By pressing F10. This will switch the IDE focus to the menu. The arrow keys can then be
used to navigate in the menu. The ENTER key should be used to select items.

3. To access menu items directly, ALT-<HIGHLIGHTED MENU LETTER> can be used to select a
menu item. Afterwards submenu entries can be selected by pressing the highlighted letter, but
without ALT. E.g. ALT-S G is a fast way to display the goto line dialog.

Every menu item is explained by a short text in the status bar.
When a local menu is available, it can be accessed by pressing the right mouse button or ALT-F10.
To exit any menu without taking any action, press the ESC key twice.

In the following, all menu entries and their actions are described.

6.4.2 The File menu

The ""File' menu contains all menu items that allow the user to load and save files, as well as to exit
the IDE.

New Opens a new, empty editor window.

New from template Prompts for a template to be used, asks to fill in any parameters, and then starts
a new editor window with the template.

Open (F3) Presents a file selection dialog, and opens the selected file in a new editor window.
Print print the contents of the current edit window.

Print setup set up the printer properties.

Reload Reload a file from disk.

Save (F2) Saves the contents of the current edit window with the current filename. If the current
edit window does not yet have a filename, a dialog is presented to enter a new filename.
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Save as Presents a dialog in which a filename can be entered. The current window’s contents are
then saved to this new filename, and the filename is stored for further save actions.

Save all Saves the contents of all edit windows.

Change dir Presents a dialog in which a directory can be selected. The current working directory is
then changed to the selected directory.

Command shell Executes a command shell. After the shell is exited, the IDE resumes. Which
command shell is executed depends on the system.

Exit (ALT-X) Exits the IDE. If any unsaved files are in the editor, the IDE will ask if these files
should be saved.

Under the "Exit" menu appear some filenames of recently used files. These entries can be used to
quickly reload these files in the editor.

6.4.3 The Edit menu

The "Edit" menu contains entries for accessing the clipboard, and undoing or redoing editing ac-
tions. Most of these functions have shortcut keys associated with them.

Undo (ALT-BKSP) Reverses the effect of the last editing action. The editing actions are stored in a
buffer. Selecting this mechanism will move backwards through this buffer, i.e. multiple undo
levels are possible. However, any selections that may have been made are not reproduced.

Redo Repeats the last action that was just undone with Undo. Redo can redo multiple undone
actions.

Cut (SHIFT-DEL) Deletes the selected text from the window and copies it to the clipboard. Any
previous clipboard contents are lost. The new clipboard contents are available for pasting
elsewhere.

Copy (CTRL-INS) Copies the current selection to the clipboard. Any previous clipboard contents
are lost. The new clipboard contents are available for pasting elsewhere.

Paste (SHIFT-INS) Inserts the current clipboard contents in the text at the cursor position. The
clipboard contents remain as they were.

Clear (CTRL-DEL) Clears (i.e. deletes) the current selection.

Select All Selects all text in the current window. The selected text can then be cut or copied to the
clipboard.

Unselect undo the selection.

Show clipboard Opens a window in which the current clipboard contents are shown.

When running an IDE under WINDOWS, the "Edit" menu has two additional entries. The IDE
maintains a separate clipboard which does not share its contents with the WINDOWS clipboard. To
access the WINDOWS clipboard, the following two entries are also present:

Copy to Windows Copy the selection to the WINDOWS clipboard.

Paste from Windows Insert the contents of the WINDOWS clipboard (if it contains text) in the edit
window at the current cursor position.
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6.4.4 The Search menu

The "Search'' menu provides access to the search and replace dialogs, as well as access to the symbol
browser of the IDE.

Find (CTRL-Q F) Presents the search dialog. A search text can be entered, and when the dialog
is closed, the entered text is searched for in the active window. If the text is found, it will be
selected.

Replace (CTRL-Q A) Presents the search and replace dialog. After the dialog is closed, the search
text will be replaced by the replace text in the active window.

Search again (CTRL-L) Repeats the last search or search and replace action, using the same pa-
rameters.

Go to line number (ALT-G) Prompts for a line number, and then jumps to this line number.

When the program and units are compiled with browse information, then the following menu entries
are also enabled:

Find procedure Not yet implemented.

Objects Asks for the name of an object and opens a browse window for this object.

Modules Asks for the name of a module and opens a browse window for this module.

Globals Asks for the name of a global symbol and opens a browse window for this global symbol.

Symbol Opens a window with all known symbols, so a symbol can be selected. After the symbol is
selected, a browse window for that symbol is opened.

6.4.5 The Run menu

The "Run'' menu contains all entries related to running a program,

Run (CTRL-F9) If the sources were modified, compiles the program. If the compile is successful,
the program is executed. If the primary file was set, then that is used to determine which
program to execute. See section 6.4.6, page 47 for more information on how to set the primary
file.

Step over (F8) Run the program until the next source line is reached. If any calls to procedures are
made, these will be executed completely as well.

Trace into (F7) Execute the current line. If the current line contains a call to another procedure, the
process will stop at the entry point of the called procedure.

Goto cursor (F4) Run the program until the execution point matches the line where the cursor is.
Until return Runs the current procedure until it exits.
Run directory Set the working directory to change to when executing the program.

Parameters Permits the entry of parameters that will be passed to the program when it is being
executed.

Program reset (CTRL-F2) if the program is being run or debugged, the debug session is aborted,
and the running program is killed.
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6.4.6 The Compile menu

The ""Compile' menu contains all entries related to compiling a program or unit.

Compile (ALT-F9) Compiles the contents of the active window, irrespective of the primary file
setting.

Make (F9) Compiles the contents of the active window, and any files that the unit or program de-
pends on and that were modified since the last compile. If the primary file was set, the primary
file is compiled instead.

Build Compiles the contents of the active window, and any files that the unit or program depends
on, whether they were modified or not. If the primary file was set, the primary file is compiled
instead.

Target Sets the target operating system for which the program should be compiled.

Primary file Sets the primary file. If set, any run or compile command will act on the primary file
instead of on the active window. The primary file need not be loaded in the IDE for this to
have effect.

Clear primary file Clears the primary file. After this command, any run or compile action will act
on the active window.

Compiler messages (F12) Displays the compiler messages window. This window will display the
messages generated by the compiler during the most recent compile.

6.4.7 The Debug menu

The ""Debug'’ menu contains menu entries to aid in debugging a program, such as setting breakpoints
and watches.

Output Show user program output in a window.
User screen (ALT-F5) Switches to the screen as it was last left by the running program.

Add watch (CTRL-F7) Adds a watch. A watch is an expression that can be evaluated by the IDE
and will be shown in a special window. Usually this is the content of some variable.

Watches Shows the current list of watches in a separate window.

Breakpoint (CTRL-F8) Sets a breakpoint at the current line. When debugging, program execution
will stop at this breakpoint.

Breakpoint list Shows the current list of breakpoints in a separate window.
Evaluate

Call stack (CTRL-F3) Shows the call stack. The call stack is the list of addresses (and filenames
and line numbers, if this information was compiled in) of procedures that are currently being
called by the running program.

Disassemble Shows the call stack.

Registers Shows the current content of the CPU registers.

Floating point unit Shows the current content of the FPU registers.

Vector unit Shows the current content of the MMX (or equivalent) registers.

GDB window Shows the GDB debugger console. This can be used to interact with the debugger
directly; here arbitrary GDB commands can be typed and the result will be shown in the
window.
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6.4.8 The Tools menu

The ""Tools" menu defines some standard tools. If new tools are defined by the user, they are ap-
pended to this menu as well.

Messages (F11) Shows the messages window. This window contains the output from one of the
tools. For more information, see section 6.10.1, page 62.

Goto next (ALT-F8) Goes to the next message.
Goto previous (ALT-F7) Goes to the previous message

Grep (SHIFT-F2) Prompts for a regular expression and options to be given to grep, and then exe-
cutes grep with the given expression and options. For this to work, the grep program must be
installed on the system, and be in a directory that is in the PATH. For more information, see
section 6.10.2, page 63.

Calculator Displays the calculator. For more information, see section 6.10.4, page 64.

Ascii table Displays the ASCII table. For more information, see section 6.10.3, page 63.

6.4.9 The Options menu

The "Options' menu is the entry point for all dialogs that are used to set options for the compiler
and the IDE, as well as the user preferences.

Mode Presents a dialog to set the current mode of the compiler. The current mode is shown at the
right of the menu entry. For more information, see section 6.11.8, page 80.

Compiler Presents a dialog that can be used to set common compiler options. These options will be
used when compiling a program or unit.

Memory sizes Presents a dialog where the stack size and the heap size for the program can be set.
These options will be used when compiling a program.

Linker Presents a dialog where some linker options can be set. These options will be used when a
program or library is compiled.

Debugger Presents a dialog where the debugging options can be set. These options are used when
compiling units or programs. Note that the debugger will not work unless debugging informa-
tion is generated for the program.

Directories Presents a dialog where the various directories needed by the compiler can be set. These
directories will be used when a program or unit is compiled.

Browser Presents a dialog where the browser options can be set. The browser options affect the
behaviour of the symbol browser of the IDE.

Tools Presents a dialog to configure the tools menu. For more information, see section 6.10.5, page
65.

Environment Presents a dialog to configure the behaviour of the IDE. A sub menu is presented with
the various aspects of the IDE:

Preferences General preferences, such as whether to save files automatically or not, and
which files should be saved. The video mode can also be set here.

Editor Controls various aspects of the edit windows.
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CodeComplete Used to set the words which can be automatically completed when typing in
the editor windows.

Codetemplates Used to define code templates, which can be inserted in an edit window.

Desktop Used to control the behaviour of the desktop, i.e. several features can be switched
on or off.

Keyboard & Mouse Can be used to select the cut/copy/paste convention, control the actions
of the mouse, and to assign commands to various mouse actions.

Learn keys Let the IDE learn keystrokes to be assigned to various commands. This is useful
mostly on LINUX and Unix-like platforms, where the actual keys sent to the IDE depend
on the terminal emulation.

Open Presents a dialog in which a file containing editor preferences can be selected. After the dialog
is closed, the preferences file will be read and the preferences will be applied.

Save Saves the current options in the default file.

Save as Saves the current options in an alternate file. A file selection dialog box will be presented
in which the alternate settings file can be specified.

Please note that options are not saved automatically. They should be saved explicitly with the
""Optionsl|Save' command.

6.4.10 The Window menu

The "Window' menu provides access to some window functions. More information on all these
functions can be found in section 6.3, page 41

Tile Tiles all opened windows on the desktop.
Cascade Cascades all opened windows on the desktop.
Close all Closes all opened windows.

Size/move (CTRL-F5) Puts the IDE in Size/move mode; after this command the active window can
be moved and resized using the arrow keys.

Zoom (F5) Zooms or unzooms the current window.

Next (F6) Activates the next window in the window list.

Previous (SHIFT-F6) Activates the previous window in the window list.
Hide (CTRL-F6) Hides the active window.

Close (ALT-F3) Closes the active window.

List (ALT-0) Shows the list of opened windows. From there a window can be activated, closed,
shown and hidden.

Refresh display Redraws the screen.
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6.4.11 The Help menu

The ""Help'' menu provides entry points to all the help functionality of the IDE, as well as the means
to customize the help system.

Contents Shows the help table of contents

Index (SHIFT-F1) Jumps to the help Index.

Topic search (CTRL-F1) Jumps to the topic associated with the currently highlighted text.
Previous topic (ALT-F1) Jumps to the previously visited topic.

Using help Displays help on using the help system.

Files Allows the configuration of the help menu. With this menu item, help files can be added to the
help system.

About Displays information about the IDE. See section 6.13.3, page 87 for more information.

6.5 Editing text

In this section, the basics of editing (source) text are explained. The IDE works like many other text
editors in this respect, so mainly the distinguishing points of the IDE will be explained.

6.5.1 Insert modes

Normally, the IDE is in insert mode. This means that any text that is typed will be inserted before
text that is present after the cursor.

In overwrite mode, any text that is typed will replace existing text.

When in insert mode, the cursor is a flat blinking line. If the IDE is in overwrite mode, the cursor is
a cube with the height of one line. Switching between insert mode and overwrite mode happens with
the INSERT key or with the CTRL-V key.

6.5.2 Blocks

The IDE handles selected text just as the Turbo Pascal IDE handles it. This is slightly different from
the way e.g. WINDOWS applications handle selected text.

Text can be selected in 3 ways:

1. Using the mouse, dragging the mouse over existing text selects it.

2. Using the keyboard, press CTRL-K B to mark the beginning of the selected text, and CTRL-K
K to mark the end of the selected text.

3. Using the keyboard, hold the SHIFT key depressed while navigating with the cursor keys.
There are also some special select commands:

1. The current line can be selected using CTRL-K L.

2. The current word can be selected using CTRL-K T.
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In the Free Pascal IDE, selected text is persistent. After selecting a range of text, the cursor can be
moved, and the selection will not be destroyed; hence the term ’block’ is more appropriate for the
selection, and will be used henceforth...

Several commands can be executed on a block:
e Move the block to the cursor location (CTRL-K V).
e Copy the block to the cursor location (CTRL-K C).
e Delete the block (CTRL-K Y).
e Write the block to a file (CTRL-K W).

e Read the contents of a file into a block (CTRL-K R). If there is already a block, this block is
not replaced by this command. The file is inserted at the current cursor position, and then the
inserted text is selected.

e Indent a block (CTRL-K I).
e Undent a block (CTRL-K U).

e Print the block contents (CTRL-K P).

When searching and replacing, the search can be restricted to the block contents.

6.5.3 Setting bookmarks

The IDE provides a feature which allows the setting of a bookmark at the current cursor position.
Later, the cursor can be returned to this position by pressing a keyboard shortcut.

Up to 9 bookmarks per source file can be set up; they are set by CTRL-K <NUMBER> (where number
is the number of the bookmark). To go to a previously set bookmark, press CTRL-Q <NUMBER>.

Currently, the bookmarks are not saved when the IDE is exited. This may change in future imple-
mentations of the IDE.

6.5.4 Jumping to a source line

It is possible to go directly to a specific source line. To do this, open the goto line dialog via the
""SearchlGoto line number'' menu.

In the dialog that appears, the line number the IDE should jump to can be entered. The goto line
dialog is shown in figure (6.4).

Figure 6.4: The goto line dialog.
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6.5.5 Syntax highlighting

The IDE is capable of syntax highlighting, i.e. the color of certain Pascal elements can be set. As
text is entered in an editor window, the IDE will try to recognise the elements, and set the color of
the text accordingly.

The syntax highlighting can be customized in the colors preferences dialog, using the menu option
"Options|Environment|Colors'. In the colors dialog, the group "Syntax" must be selected. The
item list will then display the various syntactical elements that can be colored:

Whitespace The empty text between words. Note that for whitespace, only the background color
will be used.

Comments All styles of comments in Free Pascal.

Reserved words All reserved words of Free Pascal. (See also Reference Guide).
Strings Constant string expressions.

Numbers Numbers in decimal notation.

Hex numbers Numbers in hexadecimal notation.

Assembler Any assembler blocks.

Symbols Recognised symbols (variables, types).

Directives Compiler directives.

Tabs Tab characters in the source can be given a different color than other whitespace.

The editor uses some default settings, but experimentation is the best way to find a suitable color
scheme. A good color scheme helps in detecting errors in sources, since errors will result in wrong
syntax highlighting.

6.5.6 Code Completion

Code completion means the editor will try to guess the text as it is being typed. It does this by
checking what text is typed, and as soon as the typed text can be used to identify a keyword in a list
of keywords, the keyword will be presented in a small colored box under the typed text. Pressing the
ENTER key will complete the word in the text.

There is no code completion yet for filling in function arguments, or choosing object methods as in
e.g. the Lazarus or Delphi IDEs.

Code completion can be customized in the Code completion dialog, reachable through the menu
option "'Options|Preferences|Codecomple''. The list of keywords that can be completed can be
maintained here. The code completion dialog is shown in figure (6.5).

The dialog shows in alphabetical order the currently defined keywords that are available for comple-
tion. The following buttons are available:

Ok Saves all changes and closes the dialog.

Edit Pops up a dialog that allows the editing of the currently highlighted keyword.

New Pops up a dialog that allows the entry of a new keyword which will be added to the list.
Delete Deletes the currently highlighted keyword from the list.

Cancel Discards all changes and closes the dialog.

All keywords are saved and are available the next time the IDE is started. Duplicate names are not
allowed. If an attempt is made to add a duplicate name to the list, an error will follow.
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Figure 6.5: The code completiondialog.

6.5.7 Code Templates

Code templates are a way to insert large pieces of code at once. Each code templates is identified by
a unique name. This name can be used to insert the associated piece of code in the text.

For example, the name i fthen could be associated to the following piece of code:

If | Then
begin
end

A code template can be inserted by typing its name, and pressing CTRL-J when the cursor is posi-
tioned right after the template name.

If there is no template name before the cursor, a dialog will pop up to allow selection of a template.

If a vertical bar (l) is present in the code template, the cursor is positioned on it, and the vertical bar
is deleted. In the above example, the cursor would be positioned between the i f and then, ready
to type an expression.

Code templates can be added and edited in the code templates dialog, reachable via the menu option
""Options|EnvironmentlCodeTemplates''. The code templates dialog is shown in figure (6.6).

The top listbox in the code templates dialog shows the names of all known templates. The bottom half
of the dialog shows the text associated with the currently highlighted code template. The following
buttons are available:

Ok Saves all changes and closes the dialog.

Edit Pops up a dialog that allows the editing of the currently highlighted code template. Both the
name and text can be edited.

New Pops up a dialog that allows the entry of a new code template which will be added to the list.
A name must be entered for the new template.

Delete Deletes the currently highlighted code template from the list.

Cancel Discards all changes and closes the dialog.
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Figure 6.6: The code templates dialog.

ifthen

All templates are saved and are available the next time the IDE is started.

Duplicates are not allowed. If an attempt is made to add a duplicate name to the list, an error will
occur.

6.6 Searching and replacing

The IDE allows you to search for text in the active editor window. To search for text, one of the
following can be done:

1. Select "SearchlFind'" in the menu.

2. Press CTRL-Q F.

After that, the dialog shown in figure (6.7) will pop up, and the following options can be entered:

Text to find The text to be searched for. If a block was active when the dialog was started, the first
line of this block is proposed.

Case sensitive When checked, the search is case sensitive.

Whole words only When checked, the search text must appear in the text as a complete word.
Direction The direction in which the search must be conducted, starting from the specified origin.
Scope Specifies if the search should be on the whole file, or just the selected text.

Origin Specifies if the search should start from the cursor position or the start of the scope.
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Figure 6.7: The search dialog.
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After the dialog has closed, the search is performed using the given options.

A search can be repeated (using the same options) in one of 2 ways:

1. Select "'SearchlSearch again' from the menu.

2. Press CTRL-L.

It is also possible to replace occurrences of a text with another text. This can be done in a similar
manner to searching for a text:

1. Select "'SearchlReplace' from the menu.

2. Press CTRL-Q A.

A dialog, similar to the search dialog will pop up, as shown in figure (6.8).

Figure 6.8: The replace dialog.
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In this dialog, in addition to the things that can be filled in in the search dialog, the following things
can be entered:
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New text Text that will replace the found text.

Prompt on replace Before a replacement is made, the IDE will ask for confirmation.

If the dialog is closed with the ’OK’ button, only the next occurrence of the the search text will be
replaced. If the dialog is closed with the ’Change All’ button, all occurrences of the search text will
be replaced.

6.7 The symbol browser

The symbol browser allows searching all occurrences of a symbol. A symbol can be a variable, type,
procedure or constant that occurs in the program or unit sources.

To enable the symbol browser, the program or unit must be compiled with browser information. This
can be done by setting the browser information options in the compiler options dialog.

The IDE allows to browse several types of symbols:

Procedures Allows quick jumping to a procedure definition or implementation.
Objects Quickly browse for an object.

Modules Browse a module.

Globals Browse any global symbol.

Arbitrary symbol Browse an arbitrary symbol.

In all cases, first a symbol to be browsed must be selected. After that, a browse window appears. In
the browse window, all locations where the symbol was encountered are shown. Selecting a location
and pressing the space bar will cause the editor to jump to that location; the line containing the
symbol will be highlighted.

If the location is in a source file that is not yet displayed, a new window will be opened with the
source file loaded.

After the desired location has been reached, the browser window can be closed with the usual com-
mands.

The behaviour of the browser can be customized with the browser options dialog, using the "Op-
tionsIBrowser'' menu. The browser options dialog looks like figure (6.9).

The following options can be set in the browser options dialog:

Symbols Here the types of symbols displayed in the browser can be selected:

Labels Labels are shown.
Constants Constants are shown.
Types Types are shown.

Variables Variables are shown.
Procedures Procedures are shown.
Inherited

Sub-browsing Specifies what the browser should do when displaying the members of a complex
symbol such as a record or class:

New browser The members are shown in a new browser window.
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Figure 6.9: The browser options dialog.
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Replace current The contents of the current window are replaced with the members of the
selected complex symbol.

Preferred pane Specifies what pane is shown in the browser when it is initially opened:

Scope
Reference

Display Determines how the browser should display the symbols:

Qualified symbols
Sort always Sorts the symbols in the browser window.

6.8 Running programs

A compiled program can be run straight from the IDE. This can be done in one of several ways:

1. select the ""Run/Run'' menu, or

2. press CTRL-FO.

If command line parameters should be passed to the program, then these can be set through the
""RunlParameters'' menu. The program parameters dialog looks like figure (6.10).

Figure 6.10: The program parameters dialog.

Once the program has started, it will continue to run, until
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1. the program quits normally,
2. an error happens,
3. abreakpoint is encountered, or

4. the program is reset by the user.

The last alternative is only possible if the program is compiled with debug information.

Alternatively, it is possible to position the cursor somewhere in a source file, and run the program till
the execution reaches the source line where the cursor is located. This can be done by

1. selecting ""RunlGoto Cursor' in the menu,

2. pressing F4.

Again, this is only possible if the program was compiled with debug information.

The program can also executed line by line. Pressing F8 will execute the next line of the program.
If the program wasn’t started yet, it is started. Repeatedly pressing F8 will execute the program line
by line, and the IDE will show the line to be executed in an editor window. If somewhere in the code
a call occurs to a subroutine, then pressing F8 will cause the whole routine to be executed before
control returns to the IDE. If the code of the subroutine should be stepped through as well, then F7
should be used instead. Using F7 will cause the IDE to execute line by line any subroutine that is
encountered.

If a subroutine is being stepped through, then the '"RunlUntil return'' menu will execute the program
till the current subroutine ends.

If the program should be stopped before it quits by itself, then this can be done by
1. selecting ""Run/Program reset' from the menu, or

2. pressing CTRL-F2.

The running program will then be aborted.

6.9 Debugging programs

To debug a program, it must be compiled with debug information. Compiling a program with debug
information allows you to:

1. Execute the program line by line.
2. Run the program up to a certain point (a breakpoint).

3. Inspect the contents of variables or memory locations while the program is running.

6.9.1 Using breakpoints

Breakpoints will cause a running program to stop when the execution reaches the line where the
breakpoint was set. At that moment, control is returned to the IDE, and it is possible to continue
execution.

To set a breakpoint on the current source line, use the '"DebuglBreakpoint' menu entry, or press
CTRL-F8.
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Figure 6.11: The breakpoint list window
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A list of current breakpoints can be obtained through the '"DebuglBreakpoint list' menu. The
breakpoint list window is shown in figure (6.11).

In the breakpoint list window, the following things can be done:

New Shows the breakpoint property dialog where the properties for a new breakpoint can be entered.

Edit Shows the breakpoint property dialog where the properties of the highlighted breakpoint can
be changed.

Delete Deletes the highlighted breakpoint.

The dialog can be closed with the ’Close’ button. The breakpoint properties dialog is shown in figure
(6.12)

Figure 6.12: The breakpoint properties dialog
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The following properties can be set:

Type Set the type of the breakpoint. The following types of breakpoints exist:
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function Function breakpoint. The program will stop when the function with the given name
is reached.

file-line Source line breakpoint. The program will stop when the source file with given name
and line is reached.

watch Expression breakpoint. An expression may be entered, and the program will stop as
soon as the expression changes.

awatch (access watch) Expression breakpoint. An expression that references a memory loca-
tion may be entered, and the program will stop as soon as the memory indicated by the
expression is accessed.

Address stop as soon as an address is reached.

rwatch (read watch) Expression breakpoint. An expression that references a memory loca-
tion may be entered, and the program will stop as soon as the memory indicated by the
expression is read.

Name Name of the function or file where to stop.

Conditions Here an expression can be entered which must evaluate to True for the program to stop
at the breakpoint. The expressions that can be entered must be valid GDB expressions.

Line Line number in the file where to stop. Only for breakpoints of type file-line.

Ignore count The number of times the breakpoint will be ignored before the program stops.
Remark:

1. Because the IDE uses GDB to do its debugging, it is necessary to enter all expressions in
uppercase.

2. Expressions that reference memory locations should be no longer than 16 bytes on LINUX or
g032v2 on an Intel processor, since the Intel processor’s debug registers are used to monitor
these locations.

3. Memory location watches will not function on Win32 unless a special patch is applied.

6.9.2 Using watches

When debugging information is compiled in the program, watches can be used. Watches are expres-
sions which can be evaluated by the IDE and shown in a separate window. When program execution
stops (e.g. at a breakpoint) all watches will be evaluated and their current values will be shown.

Setting a new watch can be done with the '""DebuglAdd watch' menu command or by pressing
CTRL-F7. When this is done, the watch property dialog appears, and a new expression can be
entered. The watch property dialog is shown in figure (6.13).

In the dialog, the expression can be entered. Any possible previous value and current value are
shown.

Remark: Because the IDE uses GDB to do its debugging, it is necessary to enter all expressions in uppercase
in FREEBSD.

A list of watches and their present value is available in the watches window, which can be opened
with the ""DebuglWatches'' menu. The watch list window is shown in figure (6.14).

Pressing ENTER or the space bar will show the watch property dialog for the currently highlighted
watch in the watches window.

The list of watches is updated whenever the IDE resumes control when debugging a program.
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Figure 6.13: The watch property dialog
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Figure 6.14: The watch list window.
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6.9.3 The call stack

The call stack helps in showing the program flow. It shows the list of procedures that are being
called at this moment, in reverse order. The call stack window can be shown using the '"Debugl|Call
Stack'' menu. It will show the address or procedure name of all currently active procedures with
their filename and addresses. If parameters were passed they will be shown as well. The call stack is
shown in figure (6.15).

By pressing the space bar in the call stack window, the line corresponding to the call will be high-
lighted in the edit window.

6.9.4 The GDB window

The GDB window provides direct interaction with the GDB debugger. In it, GDB commands can be
typed as they would be typed in GDB. The response of GDB will be shown in the window.

Some more information on using GDB can be found in section 10.2, page 119, but the final reference
is of course the GDB manual itself 3. The GDB window is shown in figure (6.16).

3 Available from the Free Software Foundation website.
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Figure 6.15: The call stack window.
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Figure 6.16: The GDB window
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6.10 Using Tools

The tools menu provides easy access to external tools. It also has three pre-defined tools for program-
mers: an ASCII table, a grep tool and a calculator. The output of the external tools can be accessed
through this menu as well.

6.10.1 The messages window

The output of the external utilities is redirected by the IDE and it will be displayed in the messages
window. The messages window is displayed automatically, if an external tool was run. The messages
window can also be displayed manually by selecting the menu item '"ToolsIMessages'' or by pressing
the F11 key. The messages window is shown in figure (6.17).

If the output of the tool contains filenames and line numbers, the messages window can be used to
navigate the source as in a browse window:

1. Pressing ENTER or double clicking the output line will jump to the specified source line and
close the messages window.
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Figure 6.17: The messages window

2. Pressing the space bar will jump to the specified source line, but will leave the messages
window open, with the focus on it. This allows the quick selection of another message line
with the arrow keys and jump to another location in the sources.

The algorithm which extracts the file names and line numbers from the tool output is quite sophisti-
cated, but in some cases it may fail*.

6.10.2 Grep

One external tool in the Tools menu is already predefined: a menu item to call the grep utility
("ToolsIGrep' or SHIFT-F2). Grep searches for a given string in files and returns the lines which
contain the string. The search string can even be a regular expression. For this menu item to work,
the grep program must be installed, since it is not distributed with Free Pascal.

The messages window displayed in figure (6.17) in the previous section shows the output of a typical
grep session. The messages window can be used in combination with grep to find special occur-
rences in the text.

Grep supports regular expressions. A regular expression is a string with special characters which
describe a whole class of expressions. The command line in DOS or LINUX has limited support
for regular expressions: entering 1s *.pas (or dir =*.pas) to get a list of all Pascal files in a
directory. *.pas is something similar to a regular expression. It uses a wildcard to describe a whole
class of strings: those which end on ".pas". Regular expressions offer much more: for example
[A-Z] [0-9] + describes all strings which begin with an upper case letter followed by one or more
digits.

It is outside the scope of this manual to describe regular expressions in great detail. Users of a LINUX
system can get more information on grep using man grep on the command line.

6.10.3 The ASCII table

The tools menu also provides an ASCII table ("' Tools|Ascii table'"). The ASCII table can be used to
look up ASCII codes as well as to insert characters into the window which was active when invoking
the table.

To reveal the ASCII code of a character in the table, move the cursor onto this character or click it
with the mouse. The decimal and hex values of the character are shown at the bottom on the ASCII
table window.

To insert a character into an editor window either:

1. using the mouse, double click it, or,

2. using the keyboard, press ENTER while the cursor is on it.

4Suggestions for improvement, or better yet, patches that improve the algorithm, are always welcome.
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This is especially useful for pasting graphical characters in a constant string.

The ASCII table remains active till another window is explicitly activated; thus multiple characters
can be inserted at once. The ASCII table is shown in figure (6.18).

Figure 6.18: The ASCII table
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Chap: Decimal: H Hex: BAA

6.10.4 The calculator

The calculator allows quick calculations without leaving the IDE. It is a simple calculator, since it
does not take care of operator precedence, and bracketing of operations is not (yet) supported.

The result of the calculations can be pasted into the text using the CTRL-ENTER keystroke. The
calculator dialog is shown in figure (6.19).

The calculator supports all basic mathematical operations such as addition, subtraction, division and
multiplication. They are summarised in table (6.1).

Table 6.1: Basic mathematical operations

Operation Button Key
Add two numbers + +

Subtract two numbers
Multiply two numbers

*k

>*

Divide two numbers / /

Delete the last typed digit <- BACKSPACE
Clear display C C

Change the sign +

Do per cent calculation % %

Get result of operation = ENTER

But also more sophisticated mathematical operations such as exponentiation and logarithms are sup-
ported. The advanced mathematical operations are shown in table (6.2).
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Figure 6.19: The calculator dialog

Table 6.2: Advanced mathematical operations

Operation Button Key
Calculate power x"y
Calculate the inverse value 1/x
Calculate the square root sqr
Calculate the natural logarithm log
Square the display contents x"2

Like many calculators, the calculator in the IDE also supports storing a single value in memory, and
several operations can be done on this memory value. The available operations are listed in table
(6.3)

6.10.5 Adding new tools

The tools menu can be extended with any external program which is command line oriented. The
output of such a program will be caught and displayed in the messages window.

Adding a tool to the tools menu can be done using the '""Options|Tools' menu. This will display the
tools dialog. The tools dialog is shown in figure (6.20).

In the tools dialog, the following actions are available:

New Shows the tool properties dialog where the properties of a new tool can be entered.

Edit Shows the tool properties dialog where the properties of the highlighted tool can be edited.
Delete Removes the currently highlighted tool.

Cancel Discards all changes and closes the dialog.
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Table 6.3: Advanced calculator commands

Operation Button Key
Add the displayed number to the memory M+

Subtract the displayed number from the memory M-

Move the memory contents to the display M->

Move the display contents to the memory M<—
Exchange display and memory contents M<—>

Figure 6.20: The tools configuration dialog

OK Saves all changes and closes the dialog.

The definitions of the tools are written in the desktop configuration file. So unless auto-saving of the
desktop file is enabled, the desktop file should be saved explicitly after the dialog is closed.

6.10.6 Meta parameters

When specifying the command line for the called tool, meta parameters can be used. Meta parameters
are variables and and they are replaced by their contents before passing the command line to the tool.

$CAP Captures the output of the tool.
$CAP_MSG() Captures the output of the tool and puts it in the messages window.
$CAP_EDIT() Captures the output of the tool and puts it in a separate editor window.

$COL Replaced by the column of the cursor in the active editor window. If there is no active window
or the active window is a dialog, then it is replaced by O.

$CONFIG Replaced by the complete filename of the current configuration file.

$DIR() Replaced by the full directory of the filename argument, including the trailing directory
separator. e.g.
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SDIR(’d:\data\myfile.pas’)

would return d: \data\.

$DRIVE() Replaced by the drive letter of the filename argument. e.g.
SDRIVE (‘d:\data\myfile.pas’)

would return d:.

$EDNAME Replaced by the complete file name of the file in the active edit window. If there is no
active edit window, this is an empty string.

$EXENAME Replaced by the executable name that would be created if the make command was
used. (i.e. from the 'Primary File’ setting or the active edit window).

$EXT() Replaced by the extension of the filename argument. The extension includes the dot. e.g.
SEXT (d:\data\myfile.pas’)

would return .pas.

$LINE Replaced by the line number of the cursor in the active edit window. If no edit window is
present or active, this is 0.

$NAME() Replaced by the name part (excluding extension and dot) of the filename argument. e.g.
SNAME (' d:\data\myfile.pas’)

would return myfile.

$NAMEEXT() Replaced by the name and extension part of the filename argument. e.g.
SNAMEEXT (" d:\data\myfile.pas’)

would return myfile.pas.
$NOSWAP Does nothing in the IDE; it is provided only for compatibility with Turbo Pascal.

$PROMPT() Prompt displays a dialog box that allows editing of all arguments that come after it.
Arguments that appear before the SPROMP T keyword are not presented for editing.

SPROMPT () can also take an optional filename argument. If present, SPROMPT () will load
a dialog description from the filename argument. E.g.

SPROMPT (cvsco.tdf)

would parse the file cvsco.tdf, construct a dialog with it and display it. After the dialog closed,
the information entered by the user is used to construct the tool command line.

See section 6.10.7, page 68 for more information on how to create a dialog description.
$SAVE Before executing the command, the active editor window is saved, even if it is not modified.
$SAVE_ALL Before executing the command, all unsaved editor files are saved without prompting.

$SAVE_CUR Before executing the command the contents of the active editor window are saved
without prompting if they are modified.

$SAVE_PROMPT Before executing the command, a dialog is displayed asking whether any un-
saved files should be saved before executing the command.

$WRITEMSG() Writes the parsed tool output information to a file with name as in the argument.
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6.10.7 Building a command line dialog box

When defining a tool, it is possible to show a dialog to the user, asking for additional arguments,
using the $PROMPT (filename) command-macro. The Free Pascal distribution contains some
ready-made dialogs, such as a ’grep’ dialog, a ’cvs checkout’ dialog and a ’cvs check in’ dialog. The
files for these dialogs are in the binary directory and have an extension .tdf.

In this section, the file format for the dialog description file is explained. The format of this file
resembles a windows .INI file, where each section in the file describes an element (or control) in the
dialog. An OK and a Cancel button will be added to the bottom of the dialog, so these should not
be specified in the dialog definition.

A special section is the Main section. It describes how the result of the dialog will be passed to the
command line, and the total size of the dialog.

Remark: Keywords that contain a string value should have the string value enclosed in double quotes as in
Title="Dialog title"
The Main section should contain the following keywords:

Title The title of the dialog. This will appear in the frame title of the dialog. The string should be
enclosed in quotes.

Size The size of the dialog, this is formatted as (Cols, Rows), so
Size=(59,9)

means the dialog is 59 characters wide, and 9 lines high. This size does not include the border
of the dialog.

CommandLine specifies how the command line will be passed to the program, based on the en-
tries made in the dialog. The text typed here will be passed on after replacing some control
placeholders with their values.

A control placeholder is the name of some control in the dialog, enclosed in percent (%) char-
acters. The name of the control will be replaced with the text associated with the control.
Consider the following example:

0O 0:,0 OO0 O..0

CommandLine="-n %1% %v% %i% %w% %searchstr% %$filemask%"

Here the values associated with the controls named 1, v, i, w and searchstr and
filemask will be inserted in the command line string.

Default The name of the control that is the default control, i.e. the control that is to have the focus
when the dialog is opened.

The following is an example of a valid main section:

[Main]

Title="GNU Grep"

Size=(56,9)

CommandLine="-n %1% %v% %1% %w% %$searchstr$% %$filemask%"
Default="searchstr"

After the Main section, a section must be specified for each control that should appear on the dialog.
Each section has the name of the control it describes, as in the following example:
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[CaseSensitive]
Type=CheckBox
Name="~C~ase sensitive"
Origin=(2,6)
Size=(25,1)

Default=0On

On="-1"

Each control section must have at least the following keywords associated with it:

Type The type of control. Possible values are:

Label A plain text label which will be shown on the dialog. A control can be linked to this
label, so it will be focused when the user presses the highlighted letter in the label caption
(if any).

InputLine An edit field where a text can be entered.
CheckBox A checkbox which can be in an on or off state.
Origin Specifies where the control should be located in the dialog. The origin is specified as

(left, top) and the top-left corner of the dialog has coordinate (1, 1) (not counting the
frame).

Size Specifies the size of the control, which should be specified as (Cols, Rows).

Each control has some specific keywords associated with it; they will be described below.

A label (Type=Label) has the following extra keywords associated with it:

Text the text displayed in the label. If one of the letters should be highlighted so it can be used as a
shortcut, then it should be enclosed in tilde characters (7). E.g. in

Text="~T~ext to find"

the T will be highlighted.

Link The name of a control in the dialog may be specified. If specified, pressing the label’s high-
lighted letter in combination with the ALT key will put the focus on the control specified here.

A label does not contribute to the text of the command line; it is for informational and navigational
purposes only. The following is an example of a label description section:

[label2]
Type=Label
Origin=(2, 3)
Size=(22,1)
Text="File ~m~ask"
Link="filemask"

An edit control (Type=InputLine) allows entry of arbitrary text. The text of the edit control will
be pasted in the command line if it is referenced there. The following keyword can be specified in a

inputline control section:

Value A standard value (text) for the edit control can be specified. This value will be filled in when
the dialog appears.

The following is an example of an input line section:
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[filemask]
Type=InputLine
Origin=(2,4)

Size=(22,1)

Value="x.pas x.pp *.inc"

A checkbox control (Type=CheckBox) presents a checkbox which can be in one of two states, on
or of £. With each of these states, a value can be associated which will be passed on to the command
line. The following keywords can appear in a checkbox type section:

Name The text that appears after the checkbox. If there is a highlighted letter in it, this letter can be
used to set or unset the checkbox using the ALT-letter combination.

Default Specifies whether the checkbox is checked or not when the dialog appears (value on or
off).

On The text associated with this checkbox if it is in the checked state.

Off The text associated with this checkbox if it is in the unchecked state.

The following is an example of a valid checkbox description:

[1]
Type=CheckBox
Name="~C~ase sensitive"

Origin=(2,6)
Size=(25,1)
Default=0n
On=" —i n

If the checkbox is checked, then the value —i will be added on the command line of the tool. If it is
unchecked, no value will be added.

6.11 Project management and compiler options

Project management in Pascal is much easier than with C. The compiler knows from the source which
units, sources etc. it needs. So the Free Pascal IDE does not need a full featured project manager
like some C development environments offer. Nevertheless there are some settings in the IDE which
apply to projects.

6.11.1 The primary file

Without a primary file the IDE compiles/runs the source of the active window when a program is
started. If a primary file is specified, the IDE always compiles/runs this source, even if another
source window is acti